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This document describes the new features, product enhancements, and other 
improvements implemented in the Dragonfly and Dragonfly Pro 4.1 software release. 
You should read these release notes carefully before you install this new version.
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New Features
The 4.1 software release for Dragonfly and Dragonfly Pro provides the following new 
features. For information about enhancements for Deep Learning and Bone Analysis, as 
well as improvements for window leveling, visual planes, 3D modeling, and other 
changes, see Product Enhancements on page 25.

Pore Network Modeling
The 4.1 release includes the full integration of OpenPNM, which provides porous media 
researchers with a ready-made framework for performing a wide range of pore network 
simulations. The concept of pore network modeling is to represent a porous material as 
a network or graph of pores, which form the nodes and throats that form the 
connections or edges. In a traditional pore network, the pores are the void spaces 
between solid objects. However, Dragonfly’s pore network model can consider 
connected void space or solid space and even multiple phases within each space.

Choose Tools > Pore Network Modeling on the menu bar to open the OpenPNM tab on 
the left sidebar. The pore network modeling workspace is shown below.

Pore network modeling workspace

Networks are usually “extracted” from images, in which the space is divided into 
regions, thereby reducing the complexity of the space and degrees of freedom for 
simulation. Direct numerical simulation techniques typically consider every voxel in the 
image, whereas pore network models group neighboring voxels together and treat them 
as larger regions with common properties. This allows for rapid calculations, especially 
for multiphase flows that are governed by capillary forces. Pore network models are 
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especially suitable for linear transport and percolation problems, and can also provide 
estimations of flow at the sub-pore scale.

Fluid flow simulations use the extracted information about the pore regions such as the 
diameter of an inscribed sphere, cross-sectional area, and volume. The simulations 
then use analytical solutions for flow in pipes of equivalent dimensions and shapes to 
build a set of linear algebraic equations of the form Ax + b = 0. The ‘A’s are the 
conductances of the connecting throats, the ‘b’s are a combination of the boundary 
conditions and source terms in the pores, while ‘x’ is the quantity of interest such as 
concentration of oxygen in air. The equations are cast into an adjacency matrix and 
solved using common matrix inversion techniques.

NOTE The theory of pore network modeling and details of the software are presented in: 
Gostick et al., OpenPNM: A pore network modeling package, Computing in 
Science & Engineering, 18, 4, (60-74), (2016).

Pore Network Modeling Plugins
The new plugins included in this Dragonfly release for pore network modeling are:

Generators… The Image Generator plugin can be used when tomography data is not 
available. This plugin uses PoreSpy generators functions for generating artificial images 
of porous materials for testing, validation, debugging, and illustration purposes. Go to 
https://porespy.readthedocs.io/en/master/modules/generators.html for more 
information about PoreSpy generators.

Network Extraction… Although abstract pore network models can be constructed using 

cubic lattices for the pore positions and other constructions, such as Delaunay 

tessellations, the most useful type of network model is extracted from an image. 

The Network Extraction plugin takes a dataset, ROI, or multi-ROI as an input to extract a 
network. The extraction uses PoreSpy’s SNOW (Sub-Network of an Over-segmented 
Watershed) network extraction algorithm. Details of the algorithm can be found in: Jeff 
T. Gostick, Versatile and efficient pore network extraction method using marker-based 
watershed segmentation, Physical Review E 96, 2, (2017).

Importantly, the algorithm accurately captures the size and shape of the pores across a 
wide range of porosity, which is the fraction of voxels in the image assigned to a 
particular phase. The above manuscript details how experimental percolation data was 
matched for a wide variety of materials including sandstone with 20% porosity and 
highly anisotropic fibrous material with 75% porosity.

Network Diagnostics… This plugin provides a simple way to run diagnostic simulations 
for the effective properties of the network without specifying boundary conditions.

Boundary Selector… The Boundary Selector plugin lets you select boundaries for 
performing simulations using the multi-ROI image created during network extraction.

Simulations… The Simulations plugin allows for greater control over the simulation 
variables, compared with the Network Diagnostics plugin.

Workspace Manager… This plugin is provided for cases in which OpenPNM, an advanced 
open source pore network modeling package, is required for very complex simulations. 
The Workspace Manager lets you save objects generated in Dragonfly and then open 
them using OpenPNM scripts. Go to http://openpnm.org/ to learn more about OpenPNM.



Release Notes Version 4.1
New Features ‐ Area and Depth Probe Tools 7

Object Research Systems

T
M

0
2

1
-A

-0
6

Area and Depth Probe Tools
This Dragonfly release provides the option to probe 2D and 3D neighborhoods of image 
data, multi-ROIs, and meshes and then extract measurements such as voxel counts, 
mean value, and the standard deviation of probed voxels, as well as the scalar values 
assigned to multi-ROI labels and to the vertex indexes of scalar meshes. The area and 
depth probe tools are applicable to 2D views in any oblique, and are also available for 
probing 3D views.

The new area and depth probe tools are available on the updated Probe panel, shown 
below.

Probe panel

Refer to the table below for information about the new Probe tools.

Probe tools

NOTE When probing neighborhoods, the diameter of the Disk or Sphere probe, as well as the 
side measurement of the Square or Cube probe, is selectable. Refer to the Dragonfly 
Help system for more information about the Probe measurements and for information 
about the configured actions for the Probe tools.

Description

Disk Probe…  Reports the position and values of the selected circular neighborhood that is 

aligned with the current view.

Square Probe…  Reports the position and values of the selected square neighborhood that is 

aligned with the current view.

Sphere Probe…  Reports the position and values of the selected spherical neighborhood that 

is aligned with the current view.

Cube Probe…  Reports the position and values of the selected cubic neighborhood that is 

aligned with the current view.
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Depth Probing with Annotation Tools
In addition to the depth probe tools available on the Probe panel (see Area and Depth 
Probe Tools on page 7), this software release provides the option to apply an Averaging 
mode to profile intensity perpendicular to a ruler or path within a disk or square.

The Averaging mode for rulers and paths, as well as a selectable diameter, is available 
in the updated Intensity Profile dialog, shown below.

Intensity Profile dialog

NOTE You can show the “unaveraged” minimum and maximum values as a series of dotted 
lines on the profile by selecting the Extra lines option Individual minimum and 
maximum.
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New Segmentation Options
The updated Range box, shown below, now includes options to automatically set ranges 
defined by the Otsu threshold.

Range box

Lower Otsu… Automatically sets the defined range between 0 and the Otsu threshold.

Upper Otsu… Automatically sets the defined range between the Otsu threshold and the 
maximum value in the data range.

NOTE The reformatted Range box, in which you can define intensity domains for threshold 
segmentations and for editing regions of interest, also provides more responsive 
performance and additional information, such as the selected sample’s data range and 
the range of plotted values on the histogram.

New Options for Editing Regions of Interest
To edit a segmentation, you can now automatically re-assign labeled voxels from one 
region to interest to another with the Brush tools. For example, in cases in which an 
automated bone segmentation resulted in voxels corresponding to trabecular bone 
being erroneously labeled as cortical bone or vice versa. In the example below, cortical 
bone (highlighted in yellow) was mistakenly assigned to the trabecular regions.

Automated segmentation result
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NOTE You can also choose to work in the newly introduced Exclusive mode with the Brush 
tools. In this mode, only the labeled voxels belonging to the selected regions of interest 
will be affected when painting. This option is available on the ROI Painter panel as shown 
below.

Do the following to re-assign labeled voxels from one ROI to another:

1. Select the 2D view in which you plan to edit the regions of interest.

2. Select the required regions of interest on the Data Properties and Settings panel.

The selected ROIs are identified as (A) and (B).

3. Select a 2D or 3D Brush on the ROI Painter panel.

4. Select the Exclusive option, if required.

In this mode, painting will only be applied to the labeled voxels of the selected 
regions of interest. Unlabeled voxels will not be painted.

5. Do the following, as required:

• Add and re-assign labeled voxels to ROI (A) from ROI (B) by holding down LEFT 
CTRL (or your configured Add with key) and then painting.

As shown below, only labeled voxels highlighted in yellow are re-assigned to 
those highlighted in blue when painting in Exclusive mode. Unlabeled voxels are 
not painted.

• Remove and re-assign labeled voxels from ROI(A) to ROI(B) by holding down 
LEFT SHIFT (or your configured Remove with key) and then painting.
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New Options for Segmented Regions
A number of new options, such as interfacial mesh generation, extraction of three-
phase boundaries, anisotropy computations, and smoothing, are available in this 
software release for regions of interest.

Interfacial Meshes
Normal, sampled, or cubic meshes that describe interfacial surfaces, which can be 
defined as the point of contact between two phases, can be generated for selected 
regions of interest or multi-ROIs. Right-click the required regions of interest or multi-
ROIs in the Data Properties and Settings panel and then choose 3D Modeling > 
Generate Interfacial Mesh in the pop-up menu to compute the mesh. You can choose a 
mesh type in the Generate an Interfacial Mesh dialog, shown below.

Generate an interfacial mesh dialog

An example of an interfacial mesh extracted for a segmented phase is shown in the 
following screen capture.

Interfacial mesh

NOTE If more than two regions of interest or multi-ROIs are selected, the interfacial surface 
generated will be between the first object selected (A) and the union of all other selected 
objects (B + C + D…).

NOTE Interfacial mesh representations are approximations only and computed surfaces may 
not correspond to the actual surface. Computing interfacial surfaces from regions of 
interest, which are performed in 3D with interpolated surfaces, is the recommended 
alternative for an analysis. In some cases, smoothing a mesh may help to align surface 
measurements to those computed from regions of interest.

images in: 
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Three‐Phase Boundaries
This Dragonfly release includes the option to extract graphs of the three-phase 
boundary shared between selected regions of interest and to compute pore throat 
thickness. The concept of a three-phase boundary (TPB) is most commonly described in 
fuel cell literature and employed in research, especially with respect to solid oxide fuel 
cells and polymer electrolyte membrane fuel cells. The TPB concept postulates that 
hydrogen oxidation and oxygen reduction reactions can only occur at confined spatial 
sites where electrolyte, gas, and electrically connected catalyst regions contact.

To extract a three-phase boundary graph, select the regions of interest that describe 
the three phases and then choose 3D Modeling > Extract Three‐Phase Boundary Graph 
in the pop-up menu. If you additionally need to compute throat thickness, choose 3D 
Modeling > Extract Three‐Phase Boundary Graph and Compute Throat Thickness.
Extract three‐phase boundary options for regions of interest

The result is a three-phase boundary graph that can be examined in a 3D view.

Three‐phase boundary graph
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Information and settings related to the graph are available on the Data Properties and 
Settings panel, as shown in the following screen capture. You should note that scalar 
values related to computed throat thicknesses are available in the Graph settings box 
and that these values can be further examined with the help of the Measurement 
Inspector.

Properties for three‐phase boundary graphs

NOTE You can further analyze graphs with Dragonfly’s new Graph Analysis tool (see Graph 
Analysis Tool on page 18).
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Get Skeleton of ROI as Graph
This new option for regions of interest automatically creates a graph in which the 
segments contained within the skeletonized region of interest are assigned to edges 
and vertices. The scalar values of Segment Index, Segment Euclidean Length, Segment 
Length, and Segment Tortuosity are also computed automatically and available for 
evaluation.

Right-click the required region of interest and then choose 3D Modeling > Get Skeleton 
of ROI as Graph to create a graph from an ROI, as shown below.

Graph of skeleton of an ROI

NOTE The additional options of adding a constant vertex measurement or vertex connectivities 
measurement is available in the pop-up for graphs, as shown below.

You should also note that applying a constant to the vertex radius measurement can 
facilitate the evaluation of some graphs. 
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Information about the selected graph, as well as the graph settings, are available on the 
Data Properties and Settings panel, as shown below.

Graph information and settings

NOTE You can also evaluate graphs with the help of Dragonfly’s Measurement Inspector. Right-
click the graph and then choose Measurement Inspector in the pop-up menu to open the 
Inspector tab on the right sidebar.

NOTE You can further analyze graphs with Dragonfly’s new Graph Analysis tool (see Graph 
Analysis Tool on page 18).
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Anisotropy Computations
This software release provides the opportunity compute anisotropy, which is a measure 
of how highly oriented substructures are within a volume, using the mean intercept 
length (MIL) or star volume distribution (SVD) method. To compute anisotropy, right-
click the required region of interest and then choose Compute Anisotropy Using > Mean 
Intercept Length (MIL) or Compute Anisotropy Using > Star Volume Distribution (SVD) 
in the pop-up menu. The result appears in a message box after the computation is 
complete.

Anisotropy computation

NOTE For an isotropic (perfectly oriented) system, the degree of anisotropy (DA) is equal to 0. 
As the system becomes more anisotropic (less well-oriented), the DA increases to some 
value less than 1.

The settings for computing the degree of anisotropy, for example of segmented 
trabecular bone, are available in the Set Anisotropy Parameters dialogs, shown below.

Set Anisotropy Parameters dialogs

Refer to the table below for a description of the settings applicable to anisotropy 
computations.

Settings for computing anisotropy

Description

Max iterations Is the maximum number of random points in the sample that will be analyzed. Fitting 

will stop automatically after this number is completed or if the coefficient of variation 

(tolerance) is reached.

Sampling (m) Is the resolution, or distance between subsequent samples along each vector. You 

should note that the entered value can be equal to the voxel size of the input region 

of interest.

Orientations Is the number of lines to analyze per sampling sphere.

Min iterations Is the minimum number of random points in the sample that will be analyzed.

Radius (m) Is the radius of the sampling sphere, which determines the length of each sampling 

vector.

Tolerance Is the coefficient of variation. Sampling new random points will continue until either 

a coefficient of variation equal to the tolerance is reached or the maximum number 

of iterations is completed.
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Smoothing Operation for ROIs
In some cases, such as after creating a threshold segmentation, it may be necessary to 
smooth a region of interest by removing noise from the surface of an object. This 
software release provides a new morphological operation for smoothing ROIs in the 
Morphological operations box, shown below, which is available on the ROI Tools panel.

Morphological operations

The precise effect of the smoothing operation is determined by the selected structuring 
element. If the Range option is also selected, the operation will be limited to the defined 
range. An example of smoothing is show in the following screen captures.

Original ROI (left) and smoothed ROI (right)

Export Dataset Mask
It can often be necessary, or useful, to restrict measurements or processing to a subset 
of the data that needs to be analyzed. This software release provides the option to 
export a subvolume of a dataset that only includes data values that intersect with the 
labeled voxels of a selected region of interest.

This option is available in the Dataset operations box on the ROI Tools panel, as shown 
below.

Export option

NOTE Dataset masks are exported in the shape of the selected region of interest.
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Graph Analysis Tool
Included in this software release is a Beta version of Dragonfly’s new Graph Analysis 
tool. This module lets you conduct a detailed analysis of a selected graph, such as 
plotting angles between graph edges and node-type abundance, as well as prune 
graphs in cases in which nodes or links are not compliant with the graph properties.

To open the Graph Analysis tool, right-click the graph you need to analyze and then 
choose Graph Analysis in the pop-up menu. The screen captures below include the 
Graph Analysis and the Graph Analysis Histogram dialogs.

Graph Analysis dialogs
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New Options for Box Shapes
A number of new options for automatically resizing boxes to a selected 3D object are 
now available in the Shape contextual menu and include the following:

Grow to Contain 3D Object… Expands the box to fully enclose the bounding box of the 
selected 3D object. In this case, the box will not be contracted or reoriented.

Wrap 3D Object… Resizes and/or reorients the box to tightly wrap the bounding box of 
the selected 3D object.

You can select the 3D object — such as a mesh, dataset, region of interest, or multi-ROI 
— that you want to contain or wrap to in the Choose a 3D Object dialog, shown below.

Choose a 3D Object dialog

Edit Visual Box
In some post-processing and analysis operations, it might be necessary to modify the 
spacing of a Box shape or to create a box with a specific granularity. For example, when  
choosing a box for computing vector fields describing anisotropy for a bone analysis.

To open the Edit Visual Box dialog, shown below, right-click the required Box shape and 
then choose Edit Visual Box in the pop-up menu.

Edit Visual Box dialog

NOTE You can also edit the advanced properties of a box, such as its position in space or 
orientation.
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New Image Filters
The following new filters are available in this software release for processing image data 
and for training deep learning models and classifiers for trainable segmentation.

Gradient‐Domain Fusion Filter
The new gradient-domain fusion filter helps remove inter-image discontinuties, while 
preserving intra-image detail, from registered image stacks acquired from modalities 
such as scanning electron microscopy (SEM). You should note that gradient-domain 
fusion filtering is a two-step process. First, anisotropic smoothing is applied by 
convoluting the image stack with an anisotropic Gaussian with low variance in XY and a 
higher one is Z. This step removes both low and high frequencies. Then, Poisson 
blending is applied to restore the high frequencies by fusing the high frequency of the 
original image and the lower one of the smoothed data by doing a frequency space 
blend.

The result of gradient-domain fusion filtering is illustrated in the example on the 
following page.

Original data (left) and preview after gradient‐domain fusion filtering (right)

Ring Artifact Removal
Ring artifacts can be a common issue affecting CT image systems and often correspond 
to detector defects. These artifacts usually appear at fixed positions and form a circle 
(360 degrees scan) or half circle (180 degrees scan) on tomographic slices. The best 
solution is to avoid these artifacts at the source. However, in cases in which only 
reconstructed slices are available, a new Ring Removal filter is available in this 
Dragonfly release.

NOTE For more information about his new filter, refer to: https://tomopy.readthedocs.io/en/
latest/api/tomopy.misc.corr.html#tomopy.misc.corr.remove_ring.
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Filter Updates
Some users have reported that the previews for the K-Means filters can be 
unpredictable and that results might not match previews. This was due to a random 
centroid initialization and random reassignment. In the updated version of these filters, 
the centroid initialization is now deterministic, not random.

Histogram Comparer
This software release adds the option to directly the compare the histograms of multiple 
datasets, as shown below. To compare histograms, select the required datasets in the 
Data Properties and Settings panel and then choose Compare Histograms.

Histogram Comparator

Object Descriptions
You can now add a description to any object, including image data, regions of interest, 
meshes, graphs, and others. Right-click the required object and then choose Add 
Object Description to open the dialog shown below.

Object Description dialog
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Application Recorder
This release features a simple, easy-to-use application recorder that lets you 
automatically record your full screen while working with Dragonfly. The application 
recorder, which could be used to make tutorial videos or to illustrate issues you may 
experience when working with Dragonfly, does the following:

• Records full screen in high-quality resolution and full color.

• Mouse highlighting spotlights the location of the cursor.

• Recordings can be saved in the MPEG4 (*.mp4 extension), AVI (*.avi extension), 
and GIF (*.gif extension) file formats.

Choose Tools > Application Recorder on the menu bar to open the Recorder panel, 
shown below.

Recorder panel

Export Animated GIFs
The option to export animations and application recordings in the animated GIF file 
format (*.gif extension) is now available from the 2D Animation panel, the Movie Maker, 
and from the Application Recorder.

NOTE When exporting an animated GIF, Dragonfly will first render the full sequence as an 
MPEG and then calculate the best color palette for the animated GIF, which is limited to 
256 colors. The temporary MPEG will not be retained in memory.

Apply W/L and Gamma Values
In some cases, you may want to apply the window leveling settings and gamma value 
you selected for reviewing images to exported image data. This new option, circled 
below, is available in the Save As dialog when you choose to export images.

Save As options

NOTE This is available only for Dragonfly Pro. Contact Object Research Systems for 
information about the availability of this version of Dragonfly.
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Developer Tools
A number of new tools designed for developers, such as the Script Runner and File 
Loader Generator, are available in this software release.

Script Runner
The new Script Runner is a tool designed to execute custom code. It can be used for 
introspection purposes on any Python object in the application, such as class instances, 
widgets, or ROIs. It can also be used to evaluate code snippets or to debug a few lines 
of code that is used in a file-based extension, such as a generic menu item. This tool is 
similar to the Python console for its ability to execute any code. Multiple scripts can be 
kept and recovered after the application is restarted. Moreover, the Script Runner 
provides options to repeat the execution of the provided script, enabling live 
introspection of objects being manipulated while the script is run.

Choose Developer > Script Runner on the menu bar to open the Script Runner dialog, 
shown below.

Script Runner dialog
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File Loader Generator
The new File Loader Generator generates a file canvas from the provided parameters 
recognized as a File Loader extension. A File Loader extension allows developers to load 
a dataset having a specific file format.

Choose Developer > File Loader Generator on the menu bar to open the File Loader 
Generator dialog.
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Product Enhancements
This release provides the following product enhancements for Dragonfly. Information 
about new features, such as depth probing, image filters, and the application recorder, 
as well newly implemented options for pore network modeling and segmented regions, 
is available in the topic New Features on page 5.

Bone Analysis
Dragonfly 4.1 includes a number of improvements for the Bone Analysis module. These 
enhancements include guided segmentation steps, expanded inputs for computing 
global measurements, and masking to limit lengthy computations.

Guided Segmentation Steps
A series of guided segmentation steps were added to the Bone Analysis dialog that let 
you close cortical pores and vascular inlets and fill an initial bone segmentation before 
proceeding to the separation of the cortical and trabecular bone.

The first step of the new guided segmentation scheme is shown below.

Filling bone segmentations

The second step of the guided segmentation, shown below, lets you choose a 
segmentation method for separating filled bone into cortical and trabecular 
components.

Segmenting cortical and trabecular bone
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Inputs for Computing Global Measurements
The workflow of Bone Analysis has been changed so that global measurement 
computations now rely on input cortical bone and trabecular bone segmentations, 
instead of the previously automated cortical and trabecular area segmentations. This 
change offers the opportunity to edit automated bone segmentations, as well as to 
input any region of interest that satisfies the requirements.

The new inputs for computing global measurements are shown in the following screen 
capture.

Inputs for computing global measurements

Masking for Computations
You can now apply a mask to limit the area in which average trabecular separation 
thickness will be computed.

Mask for computing average trabecular separation
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Deep Learning Improvements
This software release features a number of enhancements for Deep Learning, including 
the following:

• Custom loss function/metrics, including weighted categorical cross-entropy, Dice, 
PSNR, SSIM, and Jaccard similarity coefficient.

• Support for loading/saving a model with custom layers, loss functions, and evaluation 
metrics.

• Use of the first layers of a Deep Model to compute feature vectors in the 
Segmentation Trainer.

Model Evaluation Tool
To help evaluate Deep Learning segmentation quality, this software release features a 
model evaluation tool that lets you compare different models with selected metrics, 
such as binary cross entropy, mean absolute error, and Poisson for regression, as well 
as Jacard similarity, accuracy, and Dice for binary segmentation.

Choose Tools > Deep Learning Model Evaluation Tool on the menu bar to the open the 
Model Evaluation dialog, as shown below.

Model Evaluation dialog
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Clip Box Updates
Updates for the Clip box, shown in the following screen capture, let you add X, Y, and Z 
axis markers, as well as labels that show the length measurements for each axis or 
graduated “tick marks” that are aligned on the border of the box. You can also now 
choose to show or hide the grid lines and box borders.

Clip box

The additional settings for the Clip box are available on the Data Properties and Settings 
panel, shown below.

Clip settings
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Clip box settings

NOTE You can select the default colors for the axis and tick marks in the Colors preferences, as 
well as the default appearance of the Clip box in the 3D Settings preferences (see Views 
Preferences on page 40).

Automatic Rotations for 3D Views
Automatic rotations for 3D views, which can included in animated sequences, are 
available in this software release. Right-click the required 3D view and then choose 
Start Rotation in the pop-up menu. The rotation will start automatically from the 
current pivot position.

A number of new configurable actions for spinning objects in a 3D view are also 
available. These include the following:

Spin an object in 3D… Lets you configure a keyboard shortcut to start a spin.

Stop 3D spin… Lets you configure a keyboard shortcut to stop spinning.

Switch to 3D spin mode… Lets you configure a keyboard shortcut to enter spin mode.

Visibility Toggles
This software release introduces as series of keyboard shortcuts that let you set all 
objects selected in the Data Properties and Settings panel to non-visible or visible in the 
current 2D scene views or to toggle the opacity of ROIs, multi-ROIs, and datasets 
selected in the Data Properties and Settings panel. See Configurable Actions on page 40 
for a list of all new actions for toggling visibility.

Description

Grid lines If checked, grid lines will be shown on the Clip box.

Borders If checked, the borders of the Clip box will be shown.

Axis If checked, the X, Y, and Z axes will be identified and shown on the Clip box.

Label Lets you choose what labels you want to appear on the Clip box.

None… If selected, no labels will be shown.

Ticks (2 Axes)… If selected, tick marks will be shown at intervals equal to the grid 

size along two axes of the Clip box.

Ticks (3 Axes)… If selected, tick marks will be shown at intervals equal to the grid 

size along the X, Y, and Z axes of the Clip box.

Length… If selected, the current length of each axis of the Clip box will be shown.

You should note that the initial Clip box applied to an unstructured grid, such as a 

mesh or graph, will be padded by 1% for visualization purposes. If resized, the Clip 

box will report the actual dimensions of the unstructured grid.

Lock text If selected, text associated with the tick marks will not move when the camera is 

rotated.
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Visual Planes
In this software release, the Visual Plane panel has been removed and all plane 
settings, such as Show data, are now available on the Data Properties and Settings 
panel. In addition a new option to add multiple planes with a single click is available on 
the Shapes panel, shown below.

Shapes panel

Visual Plane options

The options in the Plane settings box on the Data Properties and Settings panel let you 
choose an initial orientation for the selected plane or to bind a plane with a selected 2D 
view. You can also choose to show corresponding 2D data in the scene’s 3D view. As is 
the case for all other shapes, you can choose the additional visual effects you want to 
apply to the selected plane in the Visual effects box.

Visual Plane settings

Description

Adds three new planes to the Data Properties and Settings panel.
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Window Leveling
This software release features a reformatted Window Leveling panel that provides more 
responsive performance, particularly when working in 3D views, and additional 
information, such as the selected sample’s data range and the range of plotted values 
on the histogram. The reformatted panel is shown below.

Window Leveling panel

NOTE This software release also features an update to PyQt from MatPlotLib for computing 
histograms, which should result in quicker computations.

Configurable Window Leveling Text Annotation
New options for selecting a mode for the Window Leveling text annotation is available in 
this software release, as shown below.

Window leveling text annotation options

You can choose to show the window width and center values (on left above) or the 
minimum and maximum values of the selected range (on right above). These options 
are available in the Miscellaneous preferences, as shown in the following screen 
capture.
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Miscellaneous preferences

Move Tool Update
An additional option — four-quadrants — is now available for manually registering 
datasets with the Move tool. This option is circled below.

Move panel

If the option is selected, the 2D views in the workspace will be divided into four 
quadrants, with the quadrants on the top left and bottom right showing one dataset and 
the remaining quadrants showing the other dataset. This arrangement was 
implemented to help align features within the selected datasets, as shown in the 
following screen capture.

2D views
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3D Modeling
A number of improvements, listed below, are available for 3D modeling in this software 
release.

Graph Appearance
The rendering of graphs is dynamic in this software release, which means that when the 
data includes a limited number of nodes, more vertices are displayed. Likewise, when 
the data includes a large number of nodes, less vertices will be displayed. This is aimed 
at helping to both accelerate and improve visualizations.

Export Graph to ROI
This software release provides the option to export a graph as a region of interest, as 
shown below.

Export graph to ROI option

Import DICOM Images for Linux
The option to import DICOM images is now available for the Linux version of Dragonfly. 
Choose File > Load DICOM Folder on the menu bar to open the Select DICOM Folder 
dialog, shown below.

Select DICOM Folder dialog
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Auto Updates for the Organizer
As an update for Dragonfly’s Organizer, you can now synchronize a project with changes 
made in the workspace. For example, after editing a region of interest. As shown below, 
simply click the Update All Objects button to save all of the changes that were made to 
all of the objects opened from the current project.

Organizer dialog

Scene’s Views Properties
The option to apply anti-aliasing to 3D scene views, in order to smooth jagged edges on 
curved lines and diagonals, is now available on the Scene’s Views Properties panel. This 
option is circled below.

Scene’s Views Properties panel

NOTE You should also notice additional improvements for setting the Lighting properties for 3D 
views.
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Configurable Axis Indicator
An additional representation for the Axis Indicator that appears in 3D views is available 
in this software release. Right-click the 3D view and then choose Axis Indicator in the 
pop-up menu. You can select Cube, Arrows, or None in the submenu.

Axis Indicator styles

NOTE You can choose a default appearance for the Axis Indicator in the 3D Settings 
preferences (see Views Preferences on page 40).

Developer Documentation
The developer documentation for Dragonfly has been updated for version 4.1. Choose 
Help > Dragonfly Developer Documentation on the menu bar to open the 
documentation system.
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Menu Bar Changes
The following changes and new items for the menu bar are implemented for Dragonfly 
4.1.

File Menu
The new items listed below, and other changes, are available for the File menu.

File menu changes

Tools Menu
The new items listed below, and other changes, are available for the Tools menu.

Tool menu changes

Developer Menu
The new items listed below, and other changes, are available for the Developer menu.

Developer menu changes

Description

Import Selected Object(s) 

from File

Lets you import selected objects from an ORS Object file (*.ORSObject extension) that contains multiple 

objects. You can select all of the objects that you want to import in the Select Objects dialog, shown 

below.

Description

Application Recorder Opens the Recorder dialog, which lets you record your screen while working with Dragonfly (see 

Application Recorder on page 22). 

Deep Learning Model 

Evaluation Tool

Opens the Model Evaluation dialog (see Model Evaluation Tool on page 27).

Pore Network Modeling Opens the OpenPNM tab on the left sidebar (see Pore Network Modeling on page 5).

Description

Script Runner Opens the Script Runner dialog (see Script Runner on page 23).

File Loader Generator Opens the File Loader Generator dialog (see File Loader Generator on page 24).
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Changes to Contextual Menus
The following changes and new items for the contextual menus are implemented for 
Dragonfly 4.1.

Data Properties and Settings Panel
The following contextual menu items are now available for datasets, annotations, 
regions of interest, multi-ROIs, meshes, shapes, vector fields, and graphs on the Data 
Properties and Settings panel.

Dataset Pop‐Up Menu
A number of new items, listed below, are available for the Dataset pop-up menu.

Dataset pop‐up menu changes

Annotation Pop‐Up Menu
A number of new items, listed below, are available for the Annotation pop-up menu.

Annotation pop‐up menu changes

ROI Pop‐Up Menu
A number of new items, listed below, are available for the Region of Interest pop-up 
menu. You should also note that the ROI pop-up menu was reformatted into groups, 
such as Modify and Transform, Connected Components, and 3D Modeling, for easier 
access to the available options.

ROI pop‐up menu changes

Description

Compare Histograms Available for multiple selections, this option lets you directly compare the histograms of selected datasets 

(see Histogram Comparer on page 21).

Edit Object Description Lets you enter a description for the selected dataset (see Object Descriptions on page 21).

Description

Edit Object Description Lets you enter a description for the selected annotation (see Object Descriptions on page 21).

Description

Edit Object Description Lets you enter a description for the selected region of interest (see Object Descriptions on page 21).

Compute Anisotropy Using Mean Intercept Length (MIL)… Lets you compute the degree of anisotropy for the selected region of 

interest using the mean intercept length (MIL) method (see Anisotropy Computations on page 16).

Star Volume Distribution (SVD)… Lets you compute the degree of anisotropy for the selected region of 

interest using the star volume distribution (SVD) method (see Anisotropy Computations on page 16).
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Multi‐ROI Pop‐Up Menu
A number of new items, listed below, are available for the Multi-ROI pop-up menu.

Multi‐ROI pop‐up menu changes

Mesh Pop‐Up Menu
A number of new items, listed below, are available for the Mesh pop-up menu.

Mesh pop‐up menu changes

Shape Pop‐Up Menu
A number of new items, listed below, are available for the Shape pop-up menu.

Shape pop‐up menu changes

   * Available for box shapes only.

Vector Field Pop‐Up Menu
A number of new items, listed below, are available for the Vector Field pop-up menu.

Pop‐up menu changes for vector fields

3D Modeling Get Skeleton of ROI as Graph… Lets you create a graph of a skeletonized region of interest (see Get 

Skeleton of ROI as Graph on page 14).

Generate Interfacial Mesh… Lets you generate an interfacial mesh from multiple regions of interest (see 

Interfacial Meshes on page 11).

Extract Three-Phase Boundary Graph and Compute Throat Thickness… Lets you extract a graph of 

the three-phase boundary shared between selected regions of interest that includes scalar values of pore 

throat thickness (see Three-Phase Boundaries on page 12).

Extract Three-Phase Boundary Graph… Lets you extract a graph of the three-phase boundary shared 

between selected regions of interest (see Three-Phase Boundaries on page 12).

Description

Description

Edit Object Description Lets you enter a description for the selected multi-ROI (see Object Descriptions on page 21).

Generate Interfacial Mesh Lets you generate an interfacial mesh from multiple multi-ROIs (see Interfacial Meshes on page 11).

Description

Edit Object Description Lets you enter a description for the selected mesh (see Object Descriptions on page 21).

Add a Constant Vertex 

Measurement

Lets you add a constant vertex measurement to the selected mesh. The name of the measurement and 

its value can be entered in the Name and Value dialogs, respectively.

Description

Grow to Contain 3D Object* Automatically expands a box to fully enclose the bounding box of a selected 3D object (see New Options 

for Box Shapes on page 19).

Wrap 3D Object* Automatically resizes and reorients a box to tightly wrap the bounding box of a selected 3D object (see 

New Options for Box Shapes on page 19).

Edit Visual Box* Lets you modify the spacing of a Box shape or to create a box with a specific granularity (see Edit Visual 

Box on page 19).

Description

Edit Object Description Lets you enter a description for the selected vector field (see Object Descriptions on page 21).
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Graph Pop‐Up Menu
A number of new items, listed below, are available for the Graph pop-up menus.

Pop‐up menu changes for graphs

Views Pop‐Up Menus
A number of new options are available for the views pop-up menus.

2D Views Pop‐Up Menu
A number of new items, listed below, are available for the 2D Views pop-up menu.

2D Views pop‐up menu changes

3D Views Pop‐Up Menu
A number of new items, listed below, are available for the 3D Views pop-up menu.

3D Views pop‐up menu changes

Description

Edit Object Description Lets you enter a description for the selected graph (see Object Descriptions on page 21).

Graph Analysis Opens the Graph Analysis dialog, in which you can conduct detailed analyzes, such as plotting angles 

between graph edges and node-type abundance, as well as prune graphs (see Graph Analysis Tool on 

page 18).

Add a Constant Vertex 

Measurement

Lets you add a constant vertex measurement to the selected graph. The name of the measurement and 

its value can be entered in the Name and Value dialogs, respectively.

Add Vertex Connectivities 

Measurement

Lets you add vertex connectivities measurements to the selected graph.

Description

Orthogonalize Other 2D 

Views

Lets you set the 2D views in a scene to be orthogonal to a selected oblique or double-oblique view.

Description

Start Rotation Lets you start an automated rotation of the view (see Automatic Rotations for 3D Views on page 29).

Axis Indicator Lets you choose a style for the Axis Indicator (see Configurable Axis Indicator on page 35).

Hide Movie Maker Lets you hide the Movie Maker panel in the selected 3D view. In this case, all thumbnails on the timeline 

will be kept.

Close Movie Maker Lets you close the Movie Maker panel in the selected 3D view. In this case, all thumbnails will be removed 

from the timeline.
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Preferences Changes
A number of new items, listed below, and other changes have been implemented for the 
setting the application preferences.

Views Preferences
Changes for the Views preferences are indicated in the following table.

Views preferences changes

Configurable Actions
Changes for the Configurable Actions preferences are indicated in the following table.

Configurable Actions preferences changes

Description

Colors

Clip box Lets you choose the default colors applied to the Clip box.

X axis… Lets you select the color used to identify the X axis.

Y axis… Lets you select the color used to identify the Y axis.

Z axis… Lets you select the color used to identify the Z axis.

Ticks color… Lets you select the color of the tick marks.

Plane color… Determines the color applied to the selected plane of a Clip box.

3D Settings

Axis indicator Lets you choose the default appearance of the Axis Indicator.

Cube… If selected, the Axis Indicator will appear as a cube.

Arrows… If selected, the Axis Indicator will appear as a series of three interconnected arrows.

None… If selected, the Axis Indicator will not be shown.

Axis indicator size… Determines the size, in screen percentage, of the Axis Indicator.

Clip box Lets you choose the default appearance of the Clip box.

Show grid lines… If selected, grid lines will appear by default on newly created Clip boxes.

Show border… If selected, borders will appear by default on newly created Clip boxes.

Show axis… If selected, axes will appear by default on newly created Clip boxes.

Show ticks… If selected, graduated “tick marks” will appear by default on newly created Clip boxes.

Axis size… Lets you choose the thickness of the axis lines.

The following settings are available in the Clip box ticks font box to customize the appearance of the clip 

box tick marks:

Font… Lets you choose a font face for the tick marks.

Font size (in screen percentage)… Lets you choose a font size, relative to the resolution of the views in 

the workspace, for the tick marks.

Minimum font size (in points)… Lets you set a minimum font size, in points, that determines how small 

the tick marks can decrease when views are resized.

Description

Set all selected objects non-

visible in 2D

Lets you configure a keyboard shortcut to set all objects selected in the Data Properties and Settings 

panel to non-visible in the current 2D scene views.

Set all selected objects 

visible in 2D

Lets you configure a keyboard shortcut to set all objects selected in the Data Properties and Settings 

panel to visible in the current 2D scene views.
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Miscellaneous
Changes for the Miscellaneous preferences are indicated in the following table.

Miscellaneous preferences changes

Plugins Toolbar
This new set of preferences lets you configure the Plugins Toolbar panel with a selected 
number of plugins.

Plugins Toolbar preferences

Toggle the 2D visibility of the 

selected object

Lets you configure a keyboard shortcut to toggle the visibility of all objects selected in the Data Properties 

and Settings panel to visible in the current 2D scene views.

Toggle the 2D opacity of 

selected ROIs, multi-ROIs, 

and datasets

Lets you configure a keyboard shortcut to toggle the opacity of ROIs, multi-ROIs, and datasets selected in 

the Data Properties and Settings panel or Opacity Settings dialog. Toggling will be between 0 and the set 

opacity value.

Spin an object in 3D Lets you configure a keyboard shortcut to start spinning objects in the selected 3D view.

Stop 3D spin Lets you configure a keyboard shortcut to stop spinning.

Switch to 3D spin mode Lets you configure a keyboard shortcut to enter spin mode.

Description

Description

Window leveling text 

annotation mode

Lets you choose the default mode — Show range or Show width and center — for the Window Leveling 

text annotation (see Configurable Window Leveling Text Annotation on page 31).
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System Requirements Changes
This release supports the base system requirements. Any differences in those 
requirements are noted below.

System requirements changes

Extending Dragonfly
Dragonfly’s Infinite Toolbox, an open exchange platform for the Dragonfly user 
community, lets you submit, browse, and download extensions that implement new 
features and workflows for all of your image processing or analysis needs.

Choose Tools > Infinite Toolbox on the menu bar to open Dragonfly’s Infinite Toolbox.

Requesting New Features
Let us know if you have a suggestion for a new feature, or an idea for an improvement 
to an existing workflow.

Version Changes to system requirements

3.0.0 None.

3.1.0 None.

NOTE Dragonfly 3.1 includes a new Anaconda distribution for Python. You should note that the current 

version of Python accessed by Dragonfly will be updated automatically to version 3.6 when you install this 

new release.

3.5.0 None.

3.6.0 None.

4.0.0 None.

NOTE The Anaconda distribution was changed to version 5.2.0 for this software release. You should also 

note that the current version of Python accessed by Dragonfly will be updated automatically to version 

3.6.5 when you install this new release. In addition, the Anaconda distribution will be installed in the 

ProgramData folder, as shown below, instead of the Program Files directory.

This change was implemented to allow users to update Dragonfly without running in Administrator mode. 

If you are updating a previous installation, the current Anaconda distribution will be deleted from the 

Program Files folder.

4.1.0 None.
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Getting Help
Learning Dragonfly
Just by taking a quick look around www.theobjects.com/dragonfly, you’ll find some 
great free resources, such as our latest instructional videos, recorded webinars, and 
user forums.

Dragonfly Workshops
Our hands-on training workshops are a great way to get up and running quickly. 
Combining in-depth instruction with class exercises, our product specialists will quickly 
teach you how to use key Dragonfly features and functions to optimize your image 
visualization and analysis tasks.

Check for upcoming workshops on our website at:
http://www.theobjects.com/dragonfly/workshops.html.

Reporting Issues
Dragonfly includes an integrated reporting module that lets you include comments and 
other information along with generated DMP and log files whenever you encounter an 
issue that results in a crash or application freeze.

Send Report to ORS dialog

You should note that you can also report an issue at any time by choosing Help > 
Report an Issue on the menu bar.
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